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Preface

Purpose and Scope

This tutorial is designed to give you an introduction to using LCTA Version 1.0 to run standardized analyses for the
LCTA data.  An orientation section will teach you the basic skills needed to use LCTA and a tutorial section teaches
you the use of LCTA by example.

Audience

This tutorial assumes you are familiar with the Microsoft Windows environment and the methods and requirements
of LCTA data collection.  If you are not familiar with the Windows environment refer to the Microsoft Windows
documentation.  You may also want to run through the Windows tutorial before preceding further with this tutorial.
You can find more information on the methods and requirements of the LCTA data collection in U.S. Army Land
Condition - Trend Analysis (LCTA) Plot Inventory Field Methods and LCTA Programs User's Guide.

Organization

This document is divided into three major components, as follows:

1. Introduction
 A brief history of  the LCTA Program Manager and it's functionality.

2. Orientation
Provides basic information on features of the LCTA Program Manager.

3. Tutorial
Provides a brief tutorial that introduces you by example to using the LCTA Program Manager.

Document Conventions

This manual uses the following syntax conventions to describe user interaction with the program.

Italic text written between the brackets < > is text that is entered at the computer.
Normal text written between the brackets < > are menu options.
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Associated Documents

The following documents cover information not provided in this tutorial.

• LCTA Programs User's Guide 
Detailed information on the LCTA programs.

• U.S. Army Land Condition - Trend Analysis (LCTA) Plot Inventory Field Method
Field methods and data collection standards of LCTA.

• Microsoft Windows User's Guide  
Microsoft Windows reference

• WordPerfect for Windows Reference (or other Windows text editor documents)
WordPerfect reference

• Microsoft Excel User's Guide 1, User's Guide 2 (or other Windows spreadsheet documents)
Excel references

• SQLBase/SQLTalk Language Reference Manual
SQL command reference for SQLBase

System Requirements

The LCTA Program Software was designed and tested for a typical LCTA computer hardware and software
configuration including:

Software
1. MS DOS 5.0
2. Microsoft Windows 3.1
3. SQLBase 5.1.x  (Gupta Tech. Inc.)

Hardware
1. 386 or 486 PC
2. 4M Ram required, 8M recommended
3. 200 MB hard drive

1. Introduction

Land Condition - Trend Analysis (LCTA) is the Army's standard inventory, monitoring, and evaluation program for
natural resources.  Using LCTA, land managers collect, store, retrieve, and analyze data related to topographic
features, soil characteristics, climatic variables, vegetation and wildlife.  In addition, LCTA is an Information
Management System (IMS).  LCTA IMS is a series of Army-developed executable programs, data storage schemes,
and commercial products.

In December of 1991 several installations collecting LCTA data received a beta version of the LCTA Program
Manager.  The beta release prototype was a DOS character based program having all of the storage and statistical
capabilities of the current release version 1.0.  This beta release provided the developers of the LCTA Version 1.0
with vital user responses and requirements.  The responses acquired from the beta version helped to establish
software design specifications for version 1.0.
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LCTA version 1.0 enables users to automate data analysis tasks and provide easy integration between LCTA  and
commercial software currently in use at the installations through a graphical user interface.  Features are available to
view, edit and enter plot data and automatically upload data into the database from field handheld computer files.
Users can select data summaries that produce graphic and tabular results and generically query the database for
installation specific information needs.  Also, by using a graphical users interface the infrequent user can utilize the
system to the fullest because of it's ease of use and reduced training requirements.

Providing standardized analysis ensures that  proper error checking is done.  In addition, a report of errors found in
the data during processing improves data integrity.  By minimizing the more complex operations of data management
and analysis, the land manager has more time to interpret the results.

2. Orientation

This section teaches you the basic skills needed to get a quick start using LCTA Version 1.0.  You will be taken on a
tour of the drop-down menus.

2.1 Operating Basics

This section helps you install the LCTA programs and reviews some fundamentals of the Windows operating system.

2.1.1 Installing LCTA

The program files are often supplied on 3.5 " or 5.25 " diskette(s) in a compressed format with an installation
program included.  To install these files you must be running Microsoft Windows 3.x.

1. Pick <File> from the Program Manager menu
2. Pick <Run> from the popup menu
3. In the command line field type <B:\Instalit>  or <A:\Instalit> depending on the drive you are using
4. Follow the installation program’s instructions.

If you chose to install the programs on drive D: the installation program will create the following directory
structures:

D:\LCTA\PRGMS\HHCOMP {LCTA Handheld Compiler files}
D:\LCTA\PRGMS {LCTA Program Manager files}
D:\LCTA\PRGMS\HHFILES {Handheld data files}
D:\LCTA\PRGMS\FILES {LCTA Program Manager output files}

It is suggested that you select the drive with the most available free space for the database since the size of these files
may become very large.

Once the files have been installed and the Windows group created or updated you will find many icons in the group.
To start a program double click on the Icon.

If you receive the program that uses a different installation scheme follow the directions included.
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2.1.2 Fundamentals of the Windows Environment

If you are familiar with the Microsoft Windows environment you may want to skip to section 2.2 Getting Started.  If
you have never used Windows you should familiarize yourself with the Windows environment by looking through
the Microsoft Windows manuals and running the Windows tutorial.

To start Windows type <WIN> at the DOS prompt.  When Windows opens you will be looking at the Program
Manager.  The Program Manager contains groups which contain program icons.  The LCTA group is named LCTA
WINAPP and contains icons for all of the LCTA programs.  Double click on the LCTA Program Manager icon to
start the program.

Figure 1 Windows LCTA WinApp group

All Windows programs will have similar characteristics.  The use of the mouse, closing programs, moving and
resizing windows are common across all applications.  All Windows programs will have a title bar, menu bar, and
work area.  LCTA Program Manager is displayed in the title bar.  The menu bar contains File, Edit, Data, Analysis,
Programs, Utilities, Window, and Help.  The work area is found below the menu bar.

2.1.2.1 Menus

Each menu item may contain commands that can not be seen on the menu bar.  To display these commands single
click on a menu item, if commands exists they will appear in a drop down menu.  Single click on one of the
commands to run that option.
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2.1.2.2 The Control Menu

Must Windows programs will have a control menu, indicated by a small rectangle in the upper left corner of the
window.  Single click on this rectangle to display the control menu.  These options will consist of options to move or
resize the window, switch to another application that is active, and close the program.  A short cut trick for closing
an application is to double click on the control menu button.

2.1.2.3 Moving and Resizing Windows

Windows can me moved or resized by using the commands in the control menu or by using mouse techniques.  To
move the window place the cursor in the title bar and hold down the left mouse key.  You may then drag the window
to a new location.  If the window takes up the full screen you may change the size by using the arrow buttons in the
upper right corner of the window.  The down arrow will minimize the application, close it to an icon and place it at
the bottom of the screen.  The up/down arrow button will reduce the size of the window.  Once the window size is
reduced, not filling the entire screen, you can use the mouse to resize the window.  Place the cursor over one of the
edges of the window.  When the cursor is placed properly the cursor will change to a double arrow.  Hold down the
left mouse key and drag the edge to the desired size.

2.1.2.4 The Clipboard

The clipboard is a temporary buffer used to store text and graphics that have been copied from an application.  When
you copy text or graphics from one application to past into another, the clipboard stores the image.

2.2 Getting Started

This section shows you how to start using the LCTA Program Manager and describes some of the main functions and
menu items.  You should be familiar with the concepts discussed above before going on with this section.  The
tutorial will discuss the program in more detail by example.

2.2.1 Starting a Session

To begin a session in LCTA double click on the LCTA Program Manager icon.  If the program automatically
connects to a database the database name will be displayed in the DB: section of the command tool.  The command
tool can be found in the lower left of the window.  If no database is connected a name is not displayed.

To connect to a database pick <FILE> from the LCTA Program Manager menu bar then <DATABASE> from the
drop down menu.  The SELECT DATABASE dialog box will appear, Figure 2.  For now do not worry about the
server name.  To see a list of available databases single click on the down arrow to the right of the database field.
Use the mouse to select the desired database and single click on the OK button.  After a few seconds the database
name will appear in the command tool area.
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Figure 2 Select database dialog

2.2.2 Getting Help

You may view the on-line help at any time by pressing the F1 key.  To get help on menu items hold down the shift
key and press the F1 function key.  Choose a menu item from the menu bar then choose a command from the drop
down menu.  Help will be displayed for that command.  The <Help> menu item will be discussed in section 2.2.10.

2.2.3 Touring the File Menu

The <File> menu allows you to open, create, and print files and select a server and database.  The <Save>, <Save
As>, <Print>, and <Printer Setup> will not be active until a text file or spreadsheet file is opened.

Click the <New Text>  item.  A blank untitled text file will appear in the working area.  Try typing something in the
text file window.  Click the <Save As> item, a dialog box for entering the file name will appear.  At this time pick
the cancel button and close the text file by double clicking in the control menu button.

Click the <New Spreadsheet> item.  A blank spreadsheet file will appear.  Place the cursor in the A1 cell, type 1 and
press enter.  Move down to cell A2 and enter 2, press enter.  Now move back to cell A1, hold down the shift key and
press the keyboard down arrow once.  Both A1 and A2 will now be highlighted.  Click on <Edit> in the menu bar
and choose <Copy>.  Now move to cell A4, hold down the shift key and press the keyboard down arrow once,
choose <Edit> from the menu bar and choose <Paste>.  The numbers have now been copied.  Close the spreadsheet
by double clicking in the control menu button, answer no to save changes

When you have a file open you can use the <Printer Setup> command to pick the desired printer and then <Print> to
send the file to a printer.

The <Database> command was covered earlier in section 2.2.1.
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Figure 3 File menu options

2.2.4 Touring the Edit Menu

The <Copy> and <Paste> commands were covered in section 2.2.3.  The <Select All> command can be used to
select all text in a file.  This is useful if you want to copy the entire file into the clipboard.  Use the <Find> command
to find text in a file, the <Next> and <Previous> commands are used in conjunction with <Find>.

Figure 4 Edit menu options
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2.2.5 Touring the Data Menu

Choose the <Data> command from the menu bar then choose <Enter/Edit/View> from the drop down menu.  A new
window will appear with LCTA Edit in the title bar and a new menu bar.  Choose <Basic> from the menu bar then
choose <View> from the drop down menu.  A dialog box listing all available year and plot data will appear.  Single
click on the desired year and plot number and pick the OK button.  A dialog will appear showing basic plot data.
Now choose the cancel button.  Now choose <Yearly> from the menu bar, <View> from the drop down menu and
then <Landuse Form>.  Again, you see the year and plot dialog box.  Pick a year and plot and choose OK.  The land
use information will appear in a dialog box.  Pick cancel and close the LCTA Edit window by double clicking on the
control menu button.

Figure 5 Data menu options
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Figure 6 Basic plot information view

Choose <Plot Summary> from the menu bar and pick a year and plot number.  An icon will appear at the bottom of
the screen.  This is the program collecting the requested information.  When the process is done the icon will
disappear.  Choose <Analysis> from the menu bar and <Waiting to View> from the drop down menu.  Pick
PLOTLIST from the dialog box.  Two files, Plotlist.txt and Plotlist.err will open in the working area.  Plotlist.txt
contains the plot summary information and Plotlist.err contains any errors found during the processing of the data.
Close both files by double clicking on the control menu button for each file window.

Figure 7 Yearly land use data view
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2.2.6 Touring the Analysis Menu

Select <Analysis> from the menu bar.  The drop down menu will have commands for all of the current standardized
summaries.  In addition, the <Waiting to View> command is also found here.  This option is used to open the results
of a summary once it has been run.  You did this in section 2.2.5 when you ran the <Plot Summary> command.

Figure 8 Analysis menu options

For now we will only see one example of an analysis.  For further information see the Tutorial section in this
document or refer to the LCTA Programs User's Guide.  Choose <Land use> from the drop down menu.  The LCTA
Data Analysis dialog box will appear (Figure 10).  Pick a year, disregard the other options at this time, and single
click on the OK button.  An icon will appear at the bottom of the screen showing the program is running.  When the
program is done the icon will disappear.  Now pick the <Waiting to View> command under the <Analysis> menu
option and choose the item beginning with LU.  Nine files will open in the working area consisting of 7 graphic files,
tabular data, and an error file.  Choose <Window> from the menu bar and <Tile> from the drop down menu.  The
files will be arranged on the screen so that all are fully visible.  Choose <Window> again, but this time pick the
<Close All> command.  All files will be closed and the working area will be empty.
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Figure 9 Additional analysis menu options

Figure 10 Data analysis option dialog

2.2.7 Touring the Programs Menu

Choose <Programs> from menu bar.  Two commands will be found in the drop down menu, <TES> and <Create HH
Pgm>.  Select the <TES> command.  This will start a help session on the Threatened & Endangered Species
program which is for information purposes only.  Close the help session by double clicking on the control menu
button.  Now choose <Programs> again and this time select the <Create HH Pgm> command.  This will start the
handheld compiler program which is used to generate source code for the CMT MC-V data loggers.  This program is
discussed further in the LCTA Programs User's Guide so close the program at this time.
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Figure 11 Programs menu options

2.2.8 Touring the Utilities Menu

Select the <Utilities> command from the menu bar.  Five options will be displayed, with <View Plot Maps> and
<Set Options> having an arrow to the far right of the command.  This denotes there is another drop down menu for
these items.  <Upload Handheld Files>, <Update Species Files>, and <SQL Selections>  will be covered in the
tutorial section.  <View Plot Maps> is not functional at this time.  For now we will only be looking at the <Set
Options> command so single click on this command.

Figure 12 Utilities menu options

The commands in the <Set Options> drop down menu represent a new kind of command.  These commands are used
to set options for the program.  The check mark to the left of the options denotes the option is active.  By default the
<Save Files>, <Load All>, and <Overwrite SQL> will be active.  Select the <Tool Bar> command.  A tool bar will
appear between the menu bar and the work area.  Now select <Utilities> again then <Set Options> and <Tool Box>.
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The LCTA Data Analysis dialog box  (Figure 10) that was discussed earlier is now visible, select a year.  Your
screen should now have both the tool bar and tool box active.

Try moving the tool box by placing the cursor in the title bar and dragging the box while holding down the left
mouse button.  Both the tool bar and tool box are used for short cuts for running commands.  When you opened the
tool box you saw the LCTA Data Analysis dialog just as you did when running analyses commands under the
<Analysis> option in the menu bar.  When you open the tool box you are creating short cuts for running all of the
analyses for a particular year.  To test this single click on the tank icon in the upper left of the tool box.  You will
know see the land use icon appear at the bottom of the screen.  When the icon disappears open the results by single
clicking on the second button in the tool bar, a large Q.  Because the <Save Files> option was active the result files
of the land use summary were saved to disk.

Now activate the <Save Work Space> by selecting <Utilities> from the menu bar,  <Set Options> from the drop
down menu, then <Save Work Space>.  Close the LCTA Program Manager by double clicking on the control menu
button above the menu bar.  Restart the LCTA Program Manager by double clicking on it's icon.  When the program
opens you will notice that all of the land use summary tables are open.  This is because we activated the <Save Work
Space> option.  This can be very handy if you have to stop working and want to return where you left off.

Connect to the database again by following the steps described in section 2.2.1 Starting a Session then close all of
the land use summary windows.

The rest of the options and button will be discussed in the tutorial section.

Figure 13 Additional utilities menu options
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Figure 14 Tool bar and tool box are active

2.2.9 Touring the Window Menu

We have used most of the options under the <Window> command.  No further examples will be done at this time.

Figure 15 Window menu options

2.2.10 Touring the Help Menu

Select the <Help> command from menu bar then choose the <Help Documents> option from the drop down menu.
Select the OK button and the LCTA Program Manager help session will open.  Single click on the Menu Selection
green text then the Help green text.  Again, single click on the Help Documents green text and an explanation of the
commands you just picked from the menu bar will be displayed.  Close the help session by double clicking on the
control menu button.  Further examples of the other options will be covered in the tutorial.
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Figure 16 Help menu options
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3. Tutorial

3.1 Introduction

Before reading through this tutorial you should have the database and LCTA software installed and have a working
understanding of the Windows environment.  You should also look at the orientation section of this manual.  It will
acquaint you with the look and feel of the LCTA Program Manager.

This tutorial will cover basic procedures for using the LCTA Program Manager.  Anything not covered here can be
found in the LCTA Programs User's Guide.

3.2 Starting the Program

To begin a session in LCTA double click on the LCTA Program Manager icon.  If the program automatically
connects to a database the database name will be displayed in the DB: section of the command tool.  The command
tools can be found in the lower left of the window.  If no database is connected a name will not be displayed.

To connect to a database pick <FILE> from the LCTA Program Manager menu bar then <DATABASE> from the
drop down menu.  The SELECT DATABASE dialog box will appear, shown below.  For now do not worry about
the server name.  To see a list of available databases single click on the down arrow to the right of the database field.
Use the mouse to select the desired database and single click on the OK button.  After a few seconds the database
name will appear in the command tool area.

Figure 17 Select database dialog

Select <Utilities> from the menu bar then <Set Options> and <Tool Bar>.  A tool bar will appear between the menu
bar and the work area.  Now select <Utilities> again then <Set Options> and <Tool Box>.  The LCTA Data Analysis
dialog box (Figure 10) is now visible, select a year.  Your screen should now have both the tool bar and tool box
active.

3.3 Running Analyses

In this section we will cover the basics of running data analyses provided in the LCTA Program Manager.  Although
all of the analyses will not be covered the procedures learned for running land use summaries apply for the other
available analyses.
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3.3.1 Updating the Species List

When wildlife and vegetation data is collected in the field codes are used to designate species and genus.    Many of
the data analyses require information about the vegetation data, such as; life (annual or perennial), form (grass, forb,
shrub or tree), and the woody type (broadleaf or coniferous).  This information is stored in the species database,
which is installed when you install the LCTA Program Manager, and in the PLNTLIST table in your installation
database.  The species database contains 30,000 plus entries for the United States.  Because only a small percentage
of these will be found on your installation the PLNTLIST table is used to store local vegetation information.  The
VERTLIST table of your installation database stores information about the wildlife.

Before running analyses for the first time or after loading new data it is a good practice to update your species list.
This serves two purposes 1) adds any new found species to the species tables, 2) provides error messages of
unknown plants that can be used for editing.

To update your species list choose the <Utilities> option from the menu bar and select the <Update Species List>
option.  Alternatively you can choose the bottom right button from the tool box.  An icon will appear at the bottom of
the screen which shows the program is running.  Double click on this icon and the Update Species List window will
open.  Notice that the status of the program is being displayed in the command tool section of the window in the
bottom left.  Once the program is done the window will close, or if minimized the icon will disappear.

Figure 18 Update species list
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Figure 19 Update species list window

Now you can look at the log file for this procedure.  Select the Q button from the tool bar, second from the left, and
select SPPLIST from the dialog box.  The SPPLIST.TXT file will be displayed in the working area.  This file
contains any errors found in the database and informs you of the species added to the species tables.  For each
message sample SQL statements are given to help you locate the data.  Running these commands will be discussed
later in this section.

Sample error message from SPPLIST.TXT:

• WARNING UNK not added to PlntList, not found in Plants Database
• SELECT PlotID,RecDate,VegLoc,VegHt FROM AerCover WHERE VegID='UNK';
• SELECT PlotID,RecDate,VegLoc FROM GndCover WHERE VegID='UNK';
• SELECT PlotID,RecDate FROM BeltMon WHERE VegID='UNK';
• SELECT PlotID,RecDate FROM BeltTran WHERE VegID='UNK';

Sample information messages from SPPLIST.TXT:

• WARNING AMCA6 added to PlntList
• SELECT * FROM PlntList WHERE VegID='AMCA6';
• WARNING RHGL added to PlntList
• SELECT * FROM PlntList WHERE VegID='RHGL';
• WARNING CODR added to PlntList
• SELECT * FROM PlntList WHERE VegID='CODR';
• WARNING ULAM added to PlntList
• SELECT * FROM PlntList WHERE VegID='ULAM';

Now to better understand the data stored in the PLNTLIST table lets use the data dictionary command to find out
about PLNTLIST.  Select <Help> from the menu bar then <Help Data Dictionary>.  Alternatively, use the data
dictionary button in the tool bar, third from the left.  In a few seconds the LCTA Data Dictionary dialog will open.
Single click on the down arrow next to the Select Table field and scroll down until you find the PLNTLIST table.
When you select PLNTLIST the rest of the dialog box will be updated with PLNTLIST information.  You can use
the Select Columns area to see information about the fields in the table.  Press cancel to close the dialog box.
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Figure 20 Plntlist data dictionary entry

3.3.2 Running Land Use Summaries

Here you will learn how to run the land use summaries and use some of the commands that will help in interpreting
the errors and results.  The steps learned here can be applied to the other analyses.

When you opened the tool box in the previous section you picked a year for the analyses in the tool box.  The tool
box gives you a short cut method for running the analyses for a particular year.  Select the land use button from tool
box,  upper left.  You will see the land use icon appear at the bottom of the screen.  Double click on the icon and a
small window will open showing the status of the program.  Notice that when the program creates the graphs for this
summary another icon will appear at the bottom of the screen.  When the program is done the window or icon will
disappear.  You may have noticed that the land use summary icon at the bottom of the screen appeared as a small
clock.  The clock hand will rotate counter clockwise showing the progress of the program.  When the hand reaches
12:00 again the clock will explode and the program is finished.

Open the land use summary results by using the queue button in the tool bar or select <Analysis> from the menu bar
and choose <Waiting to View>.  The land use summary will be listed as LU???? where ???? will be replaced with
the year of data.  When the files are opened you will see graphical and tabular results and error messages.  Select
<Window> from the menu bar and choose <Tile>.  This will arrange all of the files so that they are all visible.
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Figure 21 Land use summary results

If any errors were found during processing they are listed in the LU????.ERR file.  Maximize this file by selecting
the up arrow in the upper right corner of the LU????.ERR window.  Place the cursor on the  error number, for
example LU022, and double click, the error number will now be highlighted.  Select the help button from the tool
bar and choose OK for the Help Sessions dialog box.  Alternatively you could select <Help> from the menu bar then
choose <Help for Selection>.  An explanation of the error will appear.  Close the help window by double clicking the
control menu button.  Now select <Window> then <Close All> to close all windows in the working area.

You may have noticed that if any errors were found sample SQL commands were given.  These can be used to help
find the data causing the error.  You will learn how to run an SQL command from a new file but this procedure may
be used to run the commands found in the *.ERR files.

Select <File> from the menu bar then <New Text>.  In the untitled text window type <SELECT * FROM
INSTMAST;>, not including the brackets, and place the cursor anywhere in the line of text.  Select the SQL button
from the tool bar or choose <Utilities> from the menu bar and then <SQL Selection>.  A spreadsheet containing the
requested information will appear in the working area.  Close both the spreadsheet and the text file, do not save any
changes.

If  multiple years of data exist you will want to run land use summaries for those years also.  This time run the land
use analysis from the menu bar.  When the Data Analysis dialog box appears choose a year other than the one used in
the steps above.  Also, select the Modify Graph option by single clicking in the box next to this item.  When you
select OK the Modify Graph dialog box will appear.  It is here you can change the default titles, axes titles, chart
type, and colors.  For now we will accept the defaults by choosing the OK button.  Again the icon will appear at the
bottom of the screen and disappear when the program is finished.
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Figure 22 Data analysis options

Figure 23 Modify graph dialog

We will now compare summaries from the two years.  Select <File> from the menu bar then choose <Open>.  At the
bottom left of the dialog box there is a section titled List Files of Type, single click the down arrow to the right of the
field and choose LANDUSE.  Now only the land use files will appear in the file list section.  Find LU????-1.WMF,
where ???? is the first year of your summary, and single click on the file name.  Now scroll through the list and find
LU????-1.WMF, where ???? is the second year of your summary.  Hold down the CTRL key and single click on the
file name.  Select the OK button and the two files will open.  You can move and resize the windows so that you can
make comparison of the two summaries.  This is very useful when you are writing a report and need to make
conclusions based on the two years of data.  Select <Window> from the menu bar and choose <Close All>.
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Figure 24 Open land use files

3.4 Sharing Data With Other Programs

Because the LCTA program operates in the Windows environment sharing data with other Windows programs is
very easy.  In this section you learn how to copy tabular data to Microsoft Excel and graphs to WordPerfect.  If you
do not have these programs but have similar packages, such as; Lotus 1-2-3 for Windows and Word for Windows,
the steps should be similar.

3.4.1 Copying tabular data to Excel

Select <File> from the menu bar then choose <Open>.  List files of type LANDUSE and select one of the files with
the name of  LU????.TXT.  Place the cursor just to the left of the first class of NONE under Military Land Use.
While holding down the left mouse button drag the cursor to the end of the line after the number following the Other
class and release the mouse button.  The text will now appear as in Figure 25.  Select <Edit> from the menu bar and
choose <Copy>.  Start the Microsoft Excel program by double clicking on it's icon.  Place the cursor in cell A1,
select <Edit> from the menu bar of the Excel window and choose <Paste>.  The text now appears in the spreadsheet.
You can now perform any spreadsheet option on the data.

This process can be useful if you want to do some additional calculation of the summary results.  You can also use
the Excel graphing options to create a graph with your own options.  This same process can be used to paste data
into any Windows graphic program.
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Figure 25 Copy landuse tabular data

3.4.2 Copy graphic data to WordPerfect

Select <File> from the menu bar then choose <Open>.  List files of type LANDUSE and select one of the files with
the name of  LU????-1.WMF.  Place the cursor in the graphic window and click once to activate the window.  Select
<File> from the menu bar then choose <Copy>.  Start the WordPerfect program by double clicking on it's icon.
Place the cursor in the desired location and select <Edit> from the menu bar of the WordPerfect window and choose
<Paste>.  The graph now appears in the document.  If you have access to a color printer the graph is printed in color.

This option will prove to be very helpful when writing reports where the graphs are needed to help explain the
results.
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4. Conclusion

The LCTA program was designed to improve the capability of the user to understand and report natural resources
data for a military installation.  As you have seen through the use of a database interface program and the Windows
environment data analyses of the data is easier.  Also, the reporting capabilities are limitless with the sharing of data
with other Windows programs.

There is one important thing to keep in mind when using the LCTA program.  You are not limited to the
standardized summaries of the program.  The database stores a variety of data which can be retrieved, compared, and
further analyzed with such tools as Quest, Wintalk, Microsoft Excel, and others.  You are encouraged to explore
other summaries and reports that fully explain the condition of your training lands and the resources of your
installation.
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